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Product views

Product front view

1 Document feeder

2 Dual-head scanner

3 Output bin

4 Walk-up USB port

5 Power button

6 Tray 2

7 Tray 1

8 Front door release button

9 Color touchscreen control panel
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Product back view

1 Rear jam-access door latch

2 Straight-through paper path door

3 Hi-Speed USB 2.0 port

4 Network port

5 Fax and telephone ports

6 Power connection

7 Slot for a cable-type security lock

Serial number and model number location

The serial number and product model number label is on the back of the product.
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Control panel layout

1 Wireless light: indicates the wireless network is enabled. The light blinks while the product is establishing a connection to the
wireless network (HP LaserJet Pro 400 MFP M425dw only).

2 Touchscreen display

3 Attention light: indicates a problem with the product

4 Ready light: indicates the product is ready

5 Help button and light: provides access to the control panel help system

6 Right arrow button and light: moves the cursor to the right or moves the display image to the next screen

NOTE: This button illuminates only when the current screen can use this feature.

7 Cancel button and light: clears settings, cancels the current job or exits the current screen

NOTE: This button illuminates only when the current screen can use this feature.

8 Back button and light: returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.

9 Left arrow button and light: moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.

10 Home button and light: provides access to the Home screen

Control-panel Home screen

The Home screen provides access to the product features, and it indicates the product status.
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NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

1 Web Services  button: provides quick access to HP Web Services features, including HP ePrint

HP ePrint is a tool that prints documents by using any email enabled device to send them to the product’s email
address.

2 Setup  button: provides access to the main menus

3 Wireless  button: provides access to the Wireless Menu and wireless status information (HP LaserJet Pro 400
MFP M425dw model only)

NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

4
Network  button: provides access to network settings and information. From the network settings screen, you

can print the Network Summary page.

5 Information  button: provides product status information. From the status summary screen, you can print the
Configuration Report page.

6 Supplies  button: provides information about supplies status. From the supplies summary screen, you can print
the Supplies Status page.

7 Fax button: provides access to the Fax feature

8 Apps button: provides access to the Apps menu to print directly from Web applications that you have downloaded
from the HP ePrintCenter Web site at www.hpeprintcenter.com

9 Product status

10 Scan button: provides access to the scan feature

11 Copy button: provides access to the copy feature

12 USB button: provides access to the USB Flash Drive menu
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Print product reports
Product reports reside within the product memory. These pages help diagnose and solve problems with
the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System Setup menu on the control panel or the embedded Web server.

From the Reports menu, you can print several informative pages about the product.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

Menu item Description

Demo Page Prints a page that demonstrates print quality

Menu Structure Prints a map of the control panel-menu layout. The active settings for each menu are
listed.

Configuration Report Prints a list of all the product settings. Includes network information when the
product is connected to a network.

Supplies Status Prints the status for each toner cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Network Summary Prints a list of all product network settings

Usage Page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, monochrome (black and white) or color pages; and
reports the page count

PCL Font List Prints a list of all the PCL fonts that are installed

PS Font List Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List Prints a list of all the PCL6 fonts that are installed

Service Page Prints the service report
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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2 Paper tray

● Supported paper sizes

● Supported paper types

● Load the input trays
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best results, select the correct paper size and type in the print driver before printing.

Table 2-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2 Optional 500-
sheet Tray 3

Duplexer

Letter

216 x 279 mm (8.5 x 11 in)

Legal

216 x 356 mm (8.5 x 14 in)

A4

210 x 297 mm (8.27 x 11.69 in)

A5

148 x 210 mm (5.83 x 8.27 in)

 

A6

105 x 148 mm (4.1 x 5.8 in)

 

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in)

 

Executive

184 x 267 mm (7.24 x 10.51 in)

 

Postcard (JIS)

100 x 148 mm (3.9 x 5.8 in)

   

Double Postcard (JIS)

148 x 200 mm (5.8 x 7.9 in)

   

16K

184 x 260 mm (7.2 x 10.2 in)

   

16K

195 x 270 mm (7.7 x 10.6 in)

   

16K

197 x 273 mm (7.8 x 10.8 in)

   

8.5 x 13

216 x 330 mm (8.5 x 13 in)
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Table 2-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Optional 500-
sheet Tray 3

Duplexer

Envelope Commercial #10

105 x 241 mm (4.13 x 9.49 in)

   

Envelope B5 ISO

176 x 250 mm (6.7 x 9.8 in)

   

Envelope C5 ISO

162 x 229 mm (6.93 x 9.84 in)

   

Envelope DL ISO

110 x 220 mm (4.33 x 8.66 in)

   

Envelope Monarch

98 x 191 mm (3.9 x 7.5 in)

   

Custom

76 x 127 mm to 216 x 356 mm

(3.0 x 5.0 in to 8.5 x 14 in)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
ljm425series.

Paper type (control panel) Paper type (print driver) Tray 1 Tray 2 Optional
500-sheet
Tray 3

Duplexer

PLAIN Plain

HP EcoSMART Lite HP EcoSMART Lite

LIGHT 60-74 G Light 60-74g

MID-WEIGHT 96-110 G Mid-weight

HEAVY 111-130 G Heavy 111–130g  

EXTRA HEAVY 131–175 G Extra heavy 131–175g    

TRANSPARENCY Monochrome Laser
Transparency

 

LABELS Labels    

LETTERHEAD Letterhead

PREPRINTED Preprinted

PREPUNCHED Prepunched

COLOR Colored

ROUGH Rough  

BOND Bond

RECYCLED Recycled

ENVELOPE Envelope    
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Load the input trays

Load Tray 1

1. Open Tray 1, and pull the tray extension away
from the product.

 

2. For long paper, flip out the extension to help
hold the paper in the tray.
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3. Place the paper stack into Tray 1, and slide
the paper guides so that they are against the
sheets.

 

4. Feed the paper stack into the tray as far as it
will go.

 

Load Tray 2

1. Pull the tray out of the product.  
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2. Slide open the paper length and width guides
by pushing outward on the blue tabs.

 

3. To load Legal-size paper, extend the tray by
pressing the release button at the back of the
tray inward and pulling the back of the tray
out.

NOTE: When loaded with Legal-size paper,
the tray extends from the rear of the product
approximately 70 mm (2.75 in).

 

4. Place the paper in the tray and make sure that
it is flat at all four corners. Slide the paper
length and width guides so that they are
against the stack of paper.
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5. Push down on the paper to make sure that the
paper stack is below the paper limit tabs on
the right side and rear of the tray.

 

6. Slide the tray into the product.  

Load optional Tray 3

1. Pull the tray out of the product.  
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2. Slide open the paper length and width guides
by pushing outward on the blue tabs.

 

3. To load Legal-size paper, extend the tray by
pressing the release button at the back of the
tray inward and pulling the back of the tray
out.

NOTE: When loaded with Legal-size paper,
the tray extends from the rear of the product
approximately 70 mm (2.75 in).

 

4. Place the paper in the tray and make sure that
it is flat at all four corners. Slide the paper
length and width guides so that they are
against the stack of paper.
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5. Push down on the paper to make sure that the
paper stack is below the paper limit tabs at the
rear of the tray.

 

6. Slide the tray into the product.  
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3 Print

● Supported printer drivers (Windows)

● Change print-job settings (Windows)

● Change print-job settings (Mac OS X)

● Print tasks for Windows

● Print tasks for Mac OS X

● Additional print tasks (Windows)

● Additional print tasks (Mac OS X)

● Create archival-quality prints

● Use HP ePrint

● Use AirPrint

● Walk-up USB printing

ENWW 19



Supported printer drivers (Windows)
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). Check the installation notes and readme files on the product CD for
additional software and languages.

HP PCL 6 driver description

● Installs automatically when installing the product software

● Provided as the default driver

● Recommended for printing in all supported Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP UPD PS driver description

● Available for download from the Web at www.hp.com/support/ljm425series

● Recommended for printing with Adobe® software programs or with other highly graphics-intensive
software programs

● Provides support for printing from postscript emulation needs, or for postscript flash font support

HP UPD PCL 5 driver description

● Available for download from the Web at www.hp.com/support/ljm425series

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● Designed for use in corporate Windows environments to provide a single driver for use with
multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows computer

HP UPD PCL 6 driver description

● Available for download from the Web at www.hp.com/support/ljm425series

● Recommended for printing in all supported Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users
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● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5
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Change print-job settings (Windows)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box
to open the printer driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. From the software program, select the Print option.

2. Select the driver, and then click Properties or Preferences.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
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Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Change print-job settings (Mac OS X)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default print driver settings: The default print driver settings determine the settings used in all
print jobs, unless settings are changed in the Page Setup or Print dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. On the File menu, click the Print item.

2. In the Printer menu, select this product.

3. From the settings drop-down list, change the settings that you want to change.

Change the default settings for all print jobs

1. On the File menu, click the Print item.

2. In the Printer menu, select this product.

3. From the settings drop-down list, change the settings that you want to change.

4. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.
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3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Print tasks for Windows

Use a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.
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Create a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, or if you select a
different shortcut, all your adjustments are lost.
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5. Select the print options for the new shortcut.

NOTE: You can select the print options on
this tab or on any other tab in the printer
driver. After selecting options on other tabs,
return to the Printing Shortcuts tab before
continuing with the next step.

 

6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Automatically print on both sides with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.

NOTE: If the product is a duplex model and
only manual duplex appears, either the duplex
unit is not installed correctly in the Device
Settings tab of the Printer Properties
dialog box, or the media type is not supported
by the duplex unit.

 

Manually print on both sides with Windows

NOTE: This product includes an automatic two-sided printing feature. However, the product also can
print two-sided jobs manually if the paper is not supported by automatic two-sided printing, or if the
duplex unit has been disabled.

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.
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5. Retrieve the printed stack from the output bin
and, maintaining the same orientation, place it
in Tray 1 with the printed side down and the
top of the pages toward the product.

 

6. On the control panel, press the OK button to
print the second side of the job.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders,
Page order, and Orientation options.
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Select the page orientation (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Select the paper type (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Select the category of paper types that best
describes your paper.

 

6. Select the option for the type of paper you are
using, and click the OK button.

 

Print the first or last page on different paper (Windows)

1. From the software program, select the Print
option.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. Click the Print pages on different paper
item, and then click the Settings button to
select the necessary settings for the front cover,
other pages, and back cover.
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Scale a document to fit page size (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Create a booklet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Click the Print on both sides or Print on
both sides (manually) check box.

 

5. In the Booklet layout drop-down list, select
a binding option. The Pages per sheet
option automatically changes to 2 pages per
sheet.
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Print tasks for Mac OS X

Use a printing preset (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Presets menu, select the printing preset.

4. Click the Print button.

NOTE: To use printer-driver default settings, select the standard option.

Create a printing preset (Mac OS X)

Use printing presets to save the current printer driver settings for reuse.

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Automatically print on both sides (Mac OS X)

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. In the Printer drop-down list, select this product.

4. Select the Layout drop-down item.

5. From the Two-Sided drop-down list, select a binding option.

6. Click the Print button.

Manually print on both sides (Mac OS X)

NOTE: This product includes an automatic two-sided printing feature. However, the product also can
print two-sided jobs manually if the paper is not supported by automatic two-sided printing, or if the
duplex unit has been disabled.

1. Insert enough paper into Tray 1 to accommodate the print job.

2. On the File menu, click the Print option.

3. In the Printer drop-down list, select this product.
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4. Select the Manual Duplex drop-down item.

5. Click the Manual Duplex check box, and then select a binding option.

6. Click the Print button. Follow the instructions in the pop-up window that appears on the computer
screen before replacing the output stack in Tray 1 for printing the second half.

7. Go to the product, and remove any blank paper that is in Tray 1.

8. Insert the printed stack in Tray 1 with the printed side down and the top of the pages toward the
product.

9. If prompted, touch the appropriate control panel button to continue.

Print multiple pages on one sheet of paper (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Layout menu.
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4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the page orientation (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Click the icon that represents the page orientation that you want to use, and then click the OK
button.

5. Click the Print button.

Select the paper type (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Print a cover page (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

5. Click the Print button.

Scale a document to fit page size (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.
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3. Open the Paper Handling menu.

4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select
the size from the drop-down list.

5. Click the Print button.

Create a booklet (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Manual Duplex menu.

4. Click the Manual Duplex box.

5. Open the Booklet Printing menu.

6. Click the Format Output as Booklet box, and select a binding option.

7. Select the paper size.

8. Click the Print button.
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Additional print tasks (Windows)

Cancel a print job (Windows)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware
and Sound, click Printer. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.

Select the paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.
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5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the Save button, and then click the Close button.

Print watermarks (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.
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Additional print tasks (Mac OS X)

Cancel a print job (Mac OS X)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one print job is waiting, pressing the Cancel  button clears the print job that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Select the paper size (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

5. Click the Print button.

Select a custom paper size (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. From the Paper Size drop-down list, select the Manage Custom Sizes option.

5. Specify the dimensions for the page size, and then click the OK button.

6. Click the Print button.

Print watermarks (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Watermarks menu.
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4. Click the Watermark checkbox.

5. Beneath the check box, use the drop-down lists to set the various watermark elements.

6. Click the Print button.
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Create archival-quality prints
Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to
create documents that you want to preserve or archive.

NOTE: Archival-quality printing is accomplished by increasing the temperature of the fuser. Because
of the increased temperatures, the product prints at half-speed to avoid damage.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Archive Print button, and then touch the On button.
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Use HP ePrint
Use HP ePrint to print documents by sending them as an email attachment to the product's email
address from any email enabled device.

NOTE: The product must be connected to a wired or wireless network and have Internet access to use
HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. From the Home screen on the product control panel, touch the Web Services  button.

b. Touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the product's
email address on the control panel.

3. Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product email address that is before the @
symbol. You can get this code by printing the Web Services page from the product control
panel.

After you have added your product, you will have the option to customize the product email
address.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the email
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

4. To print a document, attach it to an email message sent to the product's email address. Both the
email message and the attachment will print.
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Use AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a network, or be connected through a wireless direct
connection. For more information about using AirPrint and about which HP products are compatible
with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/
support/ljm425series.
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Walk-up USB printing

1. Insert the USB drive into the USB port on the
front of the product.

 

2. The USB Flash Drive menu opens. Touch the
arrow buttons to scroll through the options.

● Print Documents

● View and Print Photos

● Scan to USB Drive

 

3. To print a document, touch the Print Documents
screen, and then touch the name of the folder
on the USB drive where the document is
stored. When the summary screen opens, you
can touch it to adjust the settings. Touch the
Print button to print the document.

 

4. To print photos, touch the View and Print
Photos screen, and then touch the preview
image for each photo that you want to print.
Touch the Done button. When the summary
screen opens, you can touch it to adjust the
settings. Touch the Print button to print the
photos.

 

5. Retrieve the printed job from the output bin,
and remove the USB drive.
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4 Copy

● Make a single copy

● Make multiple copies

● Copy a multiple-page original

● Collate a copy job

● Copy on both sides (duplex)

● Reduce or enlarge a copy

● Copy identification cards

● Optimize copy quality

● Adjust the lightness or darkness for copies

● Copy in draft mode

● Set the paper size and type for copying on special paper

● Set new default copy settings

● Restore copy default settings
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Make a single copy
1. Load the document onto the scanner glass or into the document feeder.

2. If you loaded the document into the document feeder, adjust the guides until they are snug against
the paper.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the Start Copy button to start copying.
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Make multiple copies
1. Load the document onto the scanner glass or into the document feeder.

2. If you loaded the document into the document feeder, adjust the guides until they are snug against
the paper.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the arrows to change the number of copies, or touch the existing number and type the
number of copies.

5. Touch the Start Copy button to start copying.
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Copy a multiple-page original
1. Insert the originals into the document feeder face-up.

NOTE: The document feeder capacity is up to 50 sheets of 75 g/m2 (20 lb) paper.

2. Adjust the guides until they are snug against the paper.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the Start Copy button to start copying.

56 Chapter 4   Copy ENWW



Collate a copy job

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Collation button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  
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Copy on both sides (duplex)

1. Load the first page of the document onto the
scanner glass, or load the whole document
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then touch the
Two-Sided button.

 

4. Select the duplexing option that you want to
use. For example, to copy a two-sided original
with two-sided output, select the 2-Sided to 2-
Sided option.

 

5. Touch the Start Copy button to start copying.  
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Reduce or enlarge a copy

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then touch the
Reduce/Enlarge button. Touch the arrow
buttons to scroll through the options, and then
touch an option to select it.

 

4. Touch the Start Copy button to start copying.  
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Copy identification cards
Use the ID Copy feature to copy both sides of identification cards, or other small-size documents, onto
the same side of one sheet of paper. The product prompts you to copy the first side and then to place
the second side on a different area of the scanner glass and copy again. The product prints both
images at the same time.

1. Load the document onto the rear-left corner of
the scanner glass.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the ID Copy button.  

4. Touch the Start Copy button to start copying.  

5. The product prompts you to place the next
page on a different section of the scanner
glass.

 

6. Touch the OK button if you have more pages
to copy, or touch the Done button if this is the
last page.

 

7. The product copies all pages onto one side of
a sheet of paper.
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Optimize copy quality
The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  
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Adjust the lightness or darkness for copies

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. On the summary screen, touch the arrow
buttons to adjust the setting.

 

4. Touch the Start Copy button to start copying.  
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Copy in draft mode
Using draft mode can use less toner and decrease the cost per page. However, using draft mode can
also reduce print quality.

HP does not recommend the full-time use of draft mode. If draft mode is used full-time, the toner supply
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no
longer acceptable, consider replacing the toner cartridge.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button.  

4. Scroll to and touch the Draft Mode button.  

5. Touch the On button.  

6. Touch the Start Copy button to start copying.  
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Set the paper size and type for copying on special
paper

1. From the Home screen on the product control
panel, touch the Copy button.

 

2. Touch the Settings button, and then scroll to
and touch the Paper button.

 

3. From the list of paper sizes, touch the name of
the paper size that is in Tray 1.

 

4. From the list of paper types, touch the name of
the paper type that is in Tray 1.

 

5. Touch the Start Copy button to start copying.  
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Set new default copy settings
You can save any combination of copy settings as the default settings to use for every job.

1. From the Home screen on the product control
panel, touch the Copy button.

 

2. Touch the Settings button.  

3. Configure the copy settings to meet your
preferences, and then scroll to and touch the
Set as New Defaults button.

 

4. Touch the Yes button.  
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Restore copy default settings
Use this procedure to restore the factory default copy settings.

1. From the Home screen on the product control
panel, touch the Copy button.

 

2. Touch the Settings button.  

3. Scroll to and touch the Restore Defaults button.  

4. Touch the OK button to restore the defaults.  
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5 Scan

● Scan by using the HP Scan software (Windows)

● Scan by using the HP Scan software (Mac OS X)

● Scan to a USB flash drive

● Set up scan to network folder and scan to email features

● Scan to a network folder

● Scan to email

● Scan by using other software
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Scan by using the HP Scan software (Windows)
1. Double-click the HP Scan icon on the computer desktop.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.
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Scan by using the HP Scan software (Mac OS X)
1. Open the Applications folder, and then click Hewlett-Packard. Double-click HP Scan.

2. Open the HP Scan menu and click Preferences. From the Scanner pop-up menu, select this
product from the list, and click Continue.

3. To use the standard preset settings, which produce acceptable results for images and text, click the
Scan button.

To use presets optimized for pictures or text documents, select a preset from the Scanning
Presets pop-up menu. To adjust the settings, click the Edit button. When you are ready to scan,
click the Scan button.

4. To scan more pages, load the next page and click Scan. Click Append to List to add the new
pages to the current list. Repeat until you have scanned all the pages.

5. Click the Save button, and then browse to the folder on your computer where you want to save
the file.

NOTE: To print the scanned images now, click the Print button.
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Scan to a USB flash drive
1. Load the document onto the scanner glass or into the document feeder.

2. Insert a USB flash drive into the port on the front of the product.

3. From the Home screen on the product control panel, touch the Scan button.

4. Touch the Scan to USB Drive screen.

5. Touch the Scan button to scan and save the file. The product creates a folder named HPSCANS
on the USB drive, and it saves the file in .PDF or .JPG format using an automatically generated file
name.

NOTE: When the summary screen opens, you can touch it to adjust settings.

You also can change the folder name.
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Set up scan to network folder and scan to email
features

These scan features are not available until you use the HP Embedded Web Server to configure them.
The following instructions describe setting up the scan settings.

1. From the Home screen on the product control panel, touch the Network  button to find the

product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Scan tab to set up the feature.
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Scan to a network folder
Use the product control panel to scan a file to a folder on the network.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Scan button.

3. Touch the Scan to Network Folder item.

4. In the list of network folders, select the folder to which you want to save the file.

5. The control panel screen displays the scan settings.

● If you want to change any of the settings, touch the Settings button, and then change the
settings.

● If the settings are correct, go to the next step.

6. Touch the Scan button to start the scan job.
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Scan to email
Use the product control panel to scan a file directly to an email address. The scanned file is sent to the
address as an email message attachment.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Scan button.

3. Touch the Scan to E-mail item.

4. Touch the Send to E-mail item.

5. Select the From address that you want to use. This is also known as an “outgoing email profile.”

NOTE: If the PIN feature has been set up, enter the PIN and touch the OK button. However, a
PIN is not required to use this feature.

6. Touch the To button and pick the address or group to which you want to send the file. Touch the
Done button when finished.

7. Touch the Subject button if you would like to add a subject line

8. Touch the Next button.

9. The control panel screen displays the scan settings.

● If you want to change any of the settings, touch the Settings button, and then change the
settings.

● If the settings are correct, go to the next step.

10. Touch the Scan button to start the scan job.
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Scan by using other software
The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product
works with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning
devices and with Macintosh-based programs that support TWAIN-compliant scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If the
program does not start automatically, the image goes to the TWAIN-compliant program immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From
Scanner or Camera in the Insert or File menu. If you are unsure whether the program is WIA-
compliant, see the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the
Hardware and Sound folder for Windows Vista and Windows 7), double-click the product icon.
This opens the standard Microsoft WIA Wizard, which enables you to scan to a file.

Scan by using optical character recognition (OCR) software

The Readiris OCR program is included on a separate CD that shipped with the product. To use the
Readiris program, install it from the appropriate software CD, and then follow the instructions in the
online Help.
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6 Fax

● Connect fax to a telephone line

● Set up fax with a telephone answering machine

● Set up fax with an extension phone

● Setup for stand-alone fax

● Configure the fax time, date, and header

● Use special characters in fax headers

● Use the phone book

● Configure send fax settings

● Configure receive fax settings

● Set fax polling

● Use fax

● Solve fax problems
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Connect fax to a telephone line
▲ Connect the telephone cable to the line port  on the product and to the telephone jack on the

wall.

The product is an analog device. HP recommends using the product on a dedicated analog telephone
line.

NOTE: Some countries/regions might require an adapter to the phone cord that came with the
product.

Set up fax with a telephone answering machine
● Set the product rings-to-answer setting for at least one ring more than the number of rings for

which the answering machine is set.

● If an answering machine is connected to the same telephone line but on a different jack (in
another room, for example), it might interfere with the product's ability to receive faxes.

Set up fax with an extension phone
With this setting turned on, you can alert the product to pick up the incoming fax call by pressing 1-2-3
sequentially on the telephone keypad. The default setting is On. Turn this setting off only if you use
pulse dialing or if you have a service from your telephone company that also uses the 1-2-3 sequence.
The telephone company service does not work if it conflicts with the product.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Fax Setup menu.

3. Scroll to and touch the Advanced Setup button.

4. Scroll to and touch the Extension Phone button, and touch the On button.

Setup for stand-alone fax
1. Unpack and set up the product.

2. From the Home screen on the product control panel, touch the Setup  button.

3. Touch the Fax Setup menu.

4. Touch the Fax Set-Up Utility button.

5. Follow the on-screen prompts and select the appropriate response for each question.

NOTE: The maximum number of characters for the fax number is 20.

NOTE: The maximum number of characters for the fax header is 25.
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Configure the fax time, date, and header

Use the control panel

To use the control panel to set the date, time, and header, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Time/Date button.

5. Select the 12-hour clock or 24-hour clock.

6. Use the keypad to enter the current time, and then touch the OK button.

7. Select the date format.

8. Use the keypad to enter the current date, and then touch the OK button.

9. Touch the Fax Header menu.

10. Use the keypad to enter your fax number, and then touch the OK button.

NOTE: The maximum number of characters for the fax number is 20.

11. Use the keypad to enter your company name or header, and then touch the OK button.

NOTE: The maximum number of characters for the fax header is 25.

Use the HP Fax Setup Wizard

If you did not complete the fax setup process at the time you installed the software, you can complete it
at any time by using the HP Fax Setup Wizard.

1. Click Start, and then click Programs.

2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3. Follow the onscreen instructions in the HP Fax Setup Wizard to configure the fax settings.

Use special characters in fax headers
When using the control panel to enter your name in the header or to enter a name for a one-touch key,
speed-dial entry, or group-dial entry, touch the 123 button to open a keypad that contains special
characters.
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Use the phone book
You can store frequently dialed fax numbers (up to 120 entries) either as individual fax numbers or as
groups of fax numbers.

Use the control panel to create and edit the fax phone book

1. From the Home screen on the product control
panel, touch the Fax button.

 

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Individual Setup button to create a
speed dial entry.

 

5. Touch an unassigned number from the list.  

6. Use the keypad to enter a name for the entry,
and then touch the OK button.

 

7. Use the keypad to enter the fax number for the
entry, and then touch the OK button.

 

Delete phone book entries

You can delete all phone book entries that are programmed in the product.

CAUTION: After phone book entries are deleted, they cannot be recovered.
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1. From the Home screen on the product control
panel, touch the Fax button.

 

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Delete Entry button. Or, to delete all
the entries, touch the Delete All Entries button.

 

5. Touch the entry that you want to delete.  

6. Touch the OK button to confirm the deletion.  

Create and edit speed-dial entries

1. From the Home screen on the product control
panel, touch the Fax button.

 

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Individual Setup button.  

5. Touch an unassigned number from the list.  
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6. Use the keypad to enter a name for the entry,
and then touch the OK button.

 

7. Use the keypad to enter the fax number for the
entry, and then touch the OK button.

 

Delete speed-dial entries

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.

4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

5. Touch the entry that you want to delete.

6. Touch the OK button to confirm the deletion.

Create and edit group-dial entries

1. Create an individual entry for each fax number that you want in the group.

a. From the Home screen on the product control panel, touch the Fax button.

b. Touch the Fax Menu button.

c. Touch the Phone Book Setup button.

d. Touch the Individual Setup button.

e. Touch an unassigned number from the list.

f. Use the keypad to enter a name for the entry, and then touch the OK button.

g. Use the keypad to enter the fax number for the entry, and then touch the OK button.

2. From the Phone Book Setup menu, touch the Group Setup button.

3. Touch an unassigned number from the list.

4. Use the keypad to enter a name for the group, and then touch the OK button.

5. Touch the name of each individual entry that you want to include in the group. When you are
finished, touch the Done Selecting button.

Delete group-dial entries

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.
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4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

5. Touch the entry that you want to delete.

6. Touch the OK button to confirm the deletion.
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Configure send fax settings

Set special dialing symbols and options

You can insert pauses into a fax number that you are dialing. Pauses are often needed when dialing
internationally or connecting to an outside line.

Special symbol Button Description

Dialing pause The Redial/Pause button is available on the control panel keypad for
entering a fax number. You can also touch the comma button to insert a
dialing pause.

Pause for dial tone The W button is available only when you are entering the fax number for a
phone book entry. This character causes the product to wait for a dial tone
before dialing the remainder of the telephone number.

Hook flash The R button is available only when you are entering the fax number for a
phone book entry. This character causes the product to insert a hook flash.

Set a dialing prefix

A dial prefix is a number or group of numbers that are automatically added to the beginning of every
fax number you enter at the control panel or from the software. The maximum number of characters for
a dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is active, you can dial a fax number without the dial prefix by using manual dial.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Dial Prefix button, and then touch the On button.

5. Use the keypad to enter the prefix, and then touch the OK button. You can use numbers, pauses,
and dialing symbols.

Set the dial tone detection

Normally, the product begins dialing a fax number immediately. If you are using the product on the
same line as your telephone, turn on the detect-dial-tone setting. This prevents the product from sending
a fax while someone is on the telephone.
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The factory-set default for detect dial tone is On for France and Hungary, and Off for all other
countries/regions.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Detect Dial Tone button, and then touch the On button.

Tone dial or pulse dial

Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

NOTE: The pulse-dialing option is not available in all countries/regions.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Dialing Mode button, and then touch the Tone or Pulse button.

Set autoredial and the time between redials

If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

Set the redial-on-busy option

If this option is on, the product redials automatically if it receives a busy signal. The factory-set default
for the redial-on-busy option is On.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Busy button, and then touch the On button.

Set the redial-on-no-answer option

If this option is on, the product redials automatically if the receiving machine does not answer. The
factory-set default for the redial-on-no-answer option is Off.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.
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3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if No Answer button, and then touch the On button.

Set the redial-on-communication-error option

If this option is on, the product redials automatically if some sort of communication error occurs. The
factory-set default for the redial-on-communication-error option is On.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Comm. Error button, and then touch the On button.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Lighter/Darker button, and then touch one of the arrows to adjust the slider.

Set resolution settings

NOTE: Increasing the resolution increases the fax file size. Larger faxes increase the send time and
could exceed the available memory in the product.

Use this procedure to change the default resolution for all fax jobs to one of the following settings:

● Standard: This setting provides the lowest quality and the fastest transmission time.

● Fine: This setting provides a higher resolution quality than Standard that is usually appropriate for
text documents.

● Superfine: This setting is best used for documents that mix text and images. The transmission time
is slower than the Fine setting but faster than the Photo setting.

● Photo: This setting produces the best images, but greatly increases the transmission time.

The factory-set default resolution setting is Fine.
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Set the default resolution setting

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fax Resolution button, and then touch one of the options.

Set billing codes

If the billing codes feature is on, the product prompts you to enter a billing code for each fax. The
product increases the billing code count for each sent fax page. This includes all types of faxes except
for poll-received, fax-forwarded, or computer-downloaded faxes. For an undefined group or a group-
dial fax, the product increases the billing code count for each successful fax that is sent to each
destination.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1
through 250.

Set the billing-code setting

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Billing Codes button, and then touch the On button.

Use billing codes

1. Load the document in the document feeder or on the scanner glass.

2. From the Home screen on the product control panel, touch the Fax button.

3. Enter the fax number, or select a speed-dial or group-dial entry.

4. Touch the Start Fax button.

5. Enter the billing code, and then touch the OK button.

Print the billing-code report

The billing-code report is a printed list of all the fax billing codes and the total number of faxes billed to
each code.

NOTE: After the product prints this report, it deletes all billing data.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.
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3. Touch the Fax Reports button.

4. Scroll to and touch the Print Billing Report button.
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Configure receive fax settings

Set fax forwarding

You can set your product to forward incoming faxes to another fax number. When the fax arrives at
your product, it is stored in the memory. The product then dials the fax number that you have specified
and sends the fax. If the product cannot forward a fax because of an error (for example, the number is
busy) and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only
forwards the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Forward Fax button, and touch the On button.

5. Use the keypad to enter the fax-forwarding number, and then touch the OK button.

Set the answer mode

Depending on the situation, set the product answer mode to Automatic, TAM, Fax/Tel, or Manual. The
factory-set default is Automatic.

● Automatic: The product answers incoming calls after a specified number of rings or upon
recognition of special fax tones.

● TAM: The product does not automatically answer the call. Instead, it waits until it detects the fax
tone.

● Fax/Tel: The product answers incoming calls immediately. If it detects the fax tone, it processes the
call as a fax. If it does not detect the fax tone, it creates an audible ring to alert you to answer the
incoming voice call.

● Manual: The product never answers calls. You must start the fax-receiving process yourself, either
by touching the Start Fax button on the control panel or by picking up a telephone that is
connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Answer Mode button, and then touch the name of the option that you want
to use.

ENWW Configure receive fax settings 87



Block or unblock fax numbers

If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that number
sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print,
and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with
a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.

NOTE: The sender of a blocked fax is not notified that the fax failed.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Block Junk Faxes button.

5. Touch the Add Number button.

6. Use the keypad to enter the fax number that you want to block, and then touch the OK button.

Set the number of rings-to-answer

When the answer mode is set to Automatic, the product rings-to-answer setting determines the number
of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of rings-
to-answer for the product must be greater than the rings-to-answer on the answering machine. This
allows the answering machine to answer the incoming call and record a message if it is a voice call.
When the answering machine answers the call, the product listens to the call and automatically
answers it if it detects fax tones.

The default setting for rings-to-answer is five for the U.S. and Canada, and two for other countries/
regions.

Use the following table to determine the number of rings-to-answer to use.

Type of telephone line Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls) Set to a number of rings within the range shown on the
control-panel display. (The minimum and maximum number of
rings allowed varies by country/region.)

One line with two separate numbers and a ring-pattern
service

One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make sure
that the product is set to a greater number of rings than the
answering system. Also, use the distinctive-ring feature to
differentiate between voice and fax calls.)
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Type of telephone line Recommended rings-to-answer setting

Shared line (receiving both fax and voice calls) with only an
attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.

To set or change the number of rings-to-answer, use the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Rings to Answer button.

5. Use the keypad to enter the number of rings, and then touch the OK button.

Set distinctive ring

Ring-pattern or distinctive-ring service is available through some local telephone companies. The service
allows you to have more than one telephone number on a single line. Each telephone number has a
unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer
the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone
company to determine if this service is available in your country/region.

NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to something
other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

● All Rings: The product answers any calls that come through the telephone line.

● Single: The product answers any calls that produce a single-ring pattern.

● Double: The product answers any calls that produce a double-ring pattern.

● Triple: The product answers any calls that produce a triple-ring pattern.

● Double and Triple: The product answers any calls that produce a double-ring or triple-ring pattern.

To change ring patterns for call answering, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Distinctive Ring button, and then touch the name of an option.
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Set notification for new fax received to computer

Use the HP Digital Fax Setup Wizard software to set up this feature. To start the software program,
from the Windows Start menu, navigate to the program group for this product, and then click the
Digital Fax Setup Wizard item. Use the software to set up alerts for digital fax jobs.

Use autoreduction for incoming faxes

If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set
default for incoming fax autoreduction is On.

If you have the Stamp Faxes option turned on, you might also want to turn on autoreduction. This
reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax onto
two pages.

NOTE: Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Set fax reprint settings

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and then touch the On button.

Set the fax sounds volume

Use this setting to control the volume of the fax sounds from the control panel. You can make changes
to the following sounds:

● Alarm Volume

● Ring Volume

● Phone Line Volume
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Set the alarm volume, phone-line volume, and ring volume

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the System Setup menu.

3. Touch the Volume Settings menu.

4. Touch the name of the volume setting that you want to adjust, and then touch one of the options.
Repeat this step for each volume setting.

Set stamp-received faxes

The product prints the sender identification information at the top of each received fax. You can also
stamp the incoming fax with your own header information to confirm the date and time that the fax was
received. The factory-set default for stamp-received faxes is Off.

NOTE: Turning on the stamp-received setting might increase the page size and cause the product to
print a second page.

NOTE: This option applies only to received faxes that the product prints.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Stamp Faxes button, and then touch the On button.

Set the private receive feature

When the private-receive feature is active, received faxes are stored in memory. A password is
required to print the stored faxes.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Private Receive button, and then touch the On button.

5. If you have not already set a system password, the product prompts you to create one.

NOTE: The system password is case-sensitive.

a. Touch the OK button, and then use the keypad to enter the system password.

b. Touch the OK button, confirm the password by entering it a second time, and then touch the
OK button to save the password.
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Set fax polling
If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This
is known as polling another machine).

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Polling Receive button.

5. Use the keypad to enter the number of the fax machine that you want to poll, and then touch the
OK button.

The product dials the other fax machine and requests the fax.
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Use fax

Supported fax programs

The PC fax program that came with the product is the only PC fax program that works with the product.
To continue to use a PC fax program previously installed on the computer, use the modem that is
already connected to the computer; it will not function through the product modem.

Cancel a fax

Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or
received.

Cancel the current fax

Press the Cancel  button on the control panel. Any pages that have not been transmitted are
canceled. Pressing the Cancel  button also stops group-dial jobs.

Cancel a pending fax job

Use this procedure to cancel a fax job in the following situations:

● The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

● The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job Status menu:

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Send Options button.

4. Touch the Fax Job Status button.

5. Touch the fax number for the job that you want to cancel.

Delete faxes from memory

Use this procedure only if you are concerned that someone else has access to your product and might
try to reprint faxes from the memory.

CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.
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3. Touch the Fax Service menu.

4. Touch the Clear Saved Faxes button.

Use fax on a DSL, PBX, or ISDN system

HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VoIP services, but they work with the proper setup and
equipment.

NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service provider.

The HP LaserJet product is an analog device that is not compatible with all digital phone environments
(unless a digital-to-analog converter is used). HP does not guarantee that the product will be compatible
with digital environments or digital-to-analog converters.

DSL

A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with those digital signals. However, if the configuration is specified
during DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an
analog signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.

NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.

A typical DSL modem employs a filter to separate the higher frequency DSL modem communication
from lower frequency analog phone and fax modem communication. It is often necessary to use a filter
with analog phones and analog fax products that are connected to a telephone line used by a DSL
modem. The DSL service provider usually provides this filter. Contact the DSL provider for more
information or for assistance.

PBX

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX
environment, it might be necessary to contact the PBX provider for assistance. HP does not guarantee
that the product will be compatible with digital environments or digital-to-analog converters.

Contact the PBX provider for more information and for assistance.

ISDN

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in an ISDN
environment, it might be necessary to contact the ISDN provider for assistance. HP does not guarantee
that the product will be compatible with ISDN digital environments or digital-to-analog converters.
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Use fax on a VoIP service

Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VoIP
network.

If the VoIP provider offers a "Pass through" mode for the connection, that will offer better fax
performance on VoIP. Also if the provider has "comfort noise" added to the line, fax performance can
be enhanced if this feature is not enabled.

If faxing problems continue, contact the VoIP provider.

Fax memory contents are retained when there is a loss of power

The flash memory protects against data loss when a power failure occurs. Other fax devices store fax
pages in either normal RAM or short-term RAM. Normal RAM immediately loses data when power is
lost, while short-term RAM loses data about 60 minutes after a power failure occurs. Flash memory can
maintain its data for years without power applied.

Security issues when connecting internal networks to public phone
lines

The product can send and receive fax data over telephone lines that conform to public switch telephone
network (PSTN) standards. The secure fax protocols make it impossible for computer viruses to be
transferred from the telephone line to a computer or network.

The following product features prevent virus transmission:

● No direct connection exists between the fax line and any devices that are connected to the USB or
Ethernet ports.

● The internal firmware cannot be modified through the fax connection.

● All fax communications go through the fax subsystem, which does not use Internet data-exchange
protocols.
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Fax from the flatbed scanner

1. Place the document face-down on the scanner
glass.

 

2. From the Home screen on the product control
panel, touch the Fax button.

 

3. Use the keypad to type the fax number.  

4. Touch the Start Fax button.  

5. The product prompts you to confirm that you
are sending from the scanner glass. Touch the
Yes button.

 

6. The product prompts you to load the first page.
Touch the OK button.

 

7. The product scans the first page and then
prompts you to load another page. If the
document has multiple pages, touch the Yes
button. Continue this process until you have
scanned all the pages.

 

8. When you have scanned the last page, touch
the No button at the prompt. The product
sends the fax.
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Fax from the document feeder

1. Insert the originals into the document feeder
face-up.

NOTE: The document feeder capacity is up
to 50 sheets of 75 g/m2 (20 lb) paper.

CAUTION: To prevent damage to the
product, do not use an original that contains
correction tape, correction fluid, paper clips,
or staples. Also, do not load photographs,
small originals, or fragile originals into the
document feeder.

 

2. Adjust the paper guides until they are snug
against the paper.

 

3. From the Home screen on the product control
panel, touch the Fax button.

 

4. Use the keypad to type the fax number.  

5. Touch the Start Fax button.  
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Use speed dials and group-dial entries

1. Load the document into the document feeder or onto the scanner glass.

2. From the Home screen on the product control panel, touch the Fax button.

3. On the keypad, touch the fax phone book icon.

4. Touch the name of the individual or group entry that you want to use.

5. Touch the Start Fax button.

Send a fax from the software

The following information provides basic instructions for sending faxes by using the software that came
with the product. All other software-related topics are covered in the software Help, which can be
opened from the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

● The product is connected directly to the computer or to a network to which the computer is
connected.

● The product software is installed on the computer.

● The computer operating system is one that this product supports.

98 Chapter 6   Fax ENWW



Send a fax from the software

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click HP.

2. Click the product name, and then click Send fax. The fax software opens.

3. Enter the fax number of one or more recipients.

4. Load the document in the document feeder.

5. Click Send Now.

Send a fax from a third-party software program, such as Microsoft Word

1. Open a document in a third-party program.

2. Click the File menu, and then click Print.

3. Select the fax print driver from the print driver drop-down list. The fax software opens.

4. Enter the fax number of one or more recipients.

5. Include any pages loaded at the product. This step is optional.

6. Click Send Now.
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Send a fax by dialing from a telephone connected to the fax line 

Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual
receive mode, you can precede the fax with a voice call to let that person know that the fax is coming.

NOTE: The telephone must be connected to the product "telephone" port .

1. Load the document into the document feeder.

2. From the Home screen on the product control panel, touch the Fax button.

3. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

4. When the recipient answers, instruct the person to start the fax machine.

5. When you hear the fax tones, touch the Start Fax button on the control panel, wait until
Connecting appears on the control panel display, and then hang up the telephone.

Send a fax with confirmation

You can set the product so that it prompts you to enter the fax number a second time to confirm that you
are sending the fax to the correct number.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Confirm Fax Number button, and touch the On button.

5. Send the fax.

Schedule a fax to be sent later

Use the product control panel to schedule a fax to be sent automatically at a future time to one or more
people. When this procedure is completed, the product scans the document into memory and then
returns to the Ready state.

NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial
attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same time
are delivered as individual faxes.
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1. Load the document into the document feeder.  

2. From the Home screen on the product control
panel, touch the Fax button.

 

3. Touch the Fax Menu button.  

4. Touch the Send Options button.  

5. Touch the Send Fax Later button.  

6. Use the keypad to enter the time of day to
send the fax. Touch the OK button.

 

7. Use the keypad to enter the date to send the
fax. Touch the OK button.

 

8. Use the keypad to type the fax number. Touch
the OK button. The product scans the
document and saves the file in memory until
the designated time.

 

Send a fax combining an electronic and paper document

Use the HP Send Fax software to set up this feature. To start the software program, from the Windows
Start menu, navigate to the program group for this product, and then click the HP Send Fax item.
Use the software to combine the documents into a single fax job.

Use access codes, credit cards, or calling cards

To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing
codes.

Send faxes internationally

To send a fax to an international destination, dial manually to allow for pauses and international
dialing codes.
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Print a fax

When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.
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Reprint a fax

When the Allow Fax Reprint feature is on, the product stores received faxes in memory. The product
has about 3.2 MB of storage space, which holds about 250 pages.

These faxes are stored continuously. Reprinting them does not clear them from the memory.

The default setting for this feature is Off.

Turn on the Allow Fax Reprint feature

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and touch the On button.

Reprint faxes

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Reprint Faxes button.

5. Touch the entry for the fax that you want to reprint.
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Automatically print on both sides of received faxes

Use the product control panel to configure the product to print two-sided copies of received faxes.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup button.

3. Touch the Advanced Setup button.

4. Touch the Print Duplex button.

5. Touch the On button.

Receive faxes when fax tones are audible on the phone line

If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:

● If you are close to the product, press the Start Fax button on the control panel.

● If not, press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and
then hang up.

NOTE: In order for the second method to work, the Extension Phone setting must be set to Yes.

Receive faxes to a computer

Print a stored fax when the private receive feature is on

To print stored faxes, you must provide the product security password. After the product prints the
stored faxes, the faxes are deleted from memory.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Print Private Faxes button.

5. Use the keypad to enter the product security password, and then touch the OK button.
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Solve fax problems

Fax troubleshooting checklist

● Several possible fixes are available. After each recommended action, retry faxing to see if the
problem is resolved.

● For best results during fax problem solving, make sure the line from the product is plugged directly
into the wall phone port. Disconnect all other devices that are connected to the product.

1. Verify that the telephone cord is plugged into the correct port on the back of the product.

2. Check the phone line by using the fax test:

a. From the Home screen on the product control panel, touch the Setup  button, and then
touch the Service menu.

b. Select the Fax Service menu.

c. Select the Run Fax Test option. The product prints a fax test report.

The report contains the following possible results:

● Pass: The report contains all of the current fax settings for review.

● Fail: The report indicates the nature of the error and contains suggestions for how to
resolve the issue.

3. Verify that the product firmware is current:

a. Print a configuration page from the control panel Reports menu to obtain the current firmware
date code.

b. Go to www.hp.com.

1. Click the Support & Drivers link.

2. Click the Download drivers and software (and firmware) link option.

3. In the For product box, type the product model number, and then click the Go button.

4. Click the link for your operating system.

5. Scroll to the Firmware section of the table.

◦ If the listed version matches the version on the configuration page, you have the
most current version.

◦ If the versions are different, download the firmware upgrade and update the
firmware on the product following the instructions onscreen.

NOTE: The product must be connected to a computer with internet access to
upgrade firmware.

◦ Resend the fax.
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4. Verify that the fax was set up when the product software was installed.

From the computer, in the HP program folder, run the Fax Setup Utility.

5. Verify that the telephone service supports analog fax.

● If using ISDN or digital PBX, contact your service provider for information about configuring
to an analog fax line.

● If using a VoIP service, change the Fax Speed setting to Slow(V.29) or disable Fast(V.34)
from the control panel. Ask if your service provider supports fax and for the recommended
fax modem speed. Some companies might require an adapter.

● If using a DSL service, ensure that a filter is included on the phone line connection to the
product. Contact the DSL service provider or purchase a DSL filter if you do not have one. If a
DSL filter is installed, try another since these filters can be defective.

6. If the error persists, find more detailed problem-solving solutions in the sections that follow this one.
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Fax trace report

A fax T.30 trace report has information that can help resolve fax transmission problems. If you call HP
for help in resolving these problems, print a T.30 trace report before you call.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Print T.30 Trace button, and then touch the Now button.

NOTE: This procedure prints a report for the last fax job, successful or not. To generate a report for
each unsuccessful fax job, select the If Error setting. To generate a report for each fax job, select the At
End of Call setting.

Fax error report printing

Use the following instructions to print fax logs and reports:

Print all fax reports

Use this procedure to print all of the following reports at one time:

● Last Call Report

● Fax Activity Log

● Phone Book Report

● Junk Fax List

● Billing Report (when Billing Codes are turned on)

● Configuration Report

● Usage Page

 

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Touch the Print All fax Reports button.

Print individual fax reports

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.
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3. Touch the Fax Reports button.

4. Touch the name of the report that you want to print.

Set the fax error report

A fax error report is a brief report that indicates the product experienced a fax job error. You can set it
to print after the following events:

● Every fax error (the factory-set default)

● Send fax error

● Receive fax error

● Never

NOTE: With this option, you will have no indication that a fax failed to be transmitted unless
you print a fax activity log.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Touch the Fax Error Report button, and then touch the printing option that you want to use.

Set the fax-error-correction mode

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Change the fax speed

The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide
standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits
per second (bps). The factory-set default for the fax-speed setting is Fast(V.34).
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You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax
overseas, or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Fax Speed button, and then touch the speed setting that you want to use.

Fax error messages 

Alert and warning messages appear temporarily and might require you to acknowledge the message
by touching the OK button to resume or by touching the Cancel  button to cancel the job. With
certain warnings, the job might not complete or the print quality might be affected. If the alert or
warning message is related to printing and the auto-continue feature is on, the product will attempt to
resume printing the job after the warning has appeared for 10 seconds without acknowledgement.

Control panel message Description Recommended action

Communication error. A fax communication error occurred between
the product and the sender or receiver.

Allow the product to retry sending the fax.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
call. Plug the product phone cord into a jack
for another phone line.

Try a different phone cord.

Set the Fax Speed option to the Slow(V.29)
setting or disable the Fast(V.34) setting.

Turn off the Error Correction feature to
prevent automatic error correction.

NOTE: Turning off the Error Correction
feature can reduce image quality.

Print the Fax Activity Log report from the
control panel to determine if the error occurs
with a specific fax number.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

Document feeder door is open.

Canceled fax.

The cover at the top of the document feeder
is open, and the product cannot send the
fax.

Close the cover, and send the fax again.
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Control panel message Description Recommended action

Fax is busy.

Canceled send.

The fax line to which you were sending a fax
was busy. The product has canceled sending
the fax.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

Check that the Redial if Busy option is
enabled.

Open the Service menu, and touch the Fax
Service button. Touch the Run Fax Test
button. This test verifies that the phone cord
is connected to the correct port and that the
phone line has a signal. The product prints a
report with the results.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

Fax is busy.

Redial pending.

The fax line to which you were sending a fax
was busy. The product automatically redials
the busy number.

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

Open the Service menu, and touch the Fax
Service button. Touch the Run Fax Test
button. This test verifies that the phone cord
is connected to the correct port and that the
phone line has a signal. The product prints a
report with the results.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

110 Chapter 6   Fax ENWW

http://www.hp.com/support/ljm425series
http://www.hp.com/support/ljm425series


Control panel message Description Recommended action

Fax receive error. An error occurred while trying to receive a
fax.

Ask the sender to resend the fax.

Try faxing back to the sender or another fax
machine.

Check for a dial tone on the phone line by
touching the Start Fax button.

Check that the telephone cord is securely
connected by unplugging and replugging the
cord.

Make sure that you are using the telephone
cord that came with the product.

Open the Service menu, and touch the Fax
Service button. Touch the Run Fax Test
button. This test verifies that the phone cord
is connected to the correct port and that the
phone line has a signal. The product prints a
report with the results.

Decrease the fax speed. Ask the sender to
resend the fax.

Turn off error-correction mode. Ask the
sender to resend the fax.

NOTE: Turning off error-correction mode
can reduce the quality of the fax image.

Connect the product to a different phone
line.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.
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Control panel message Description Recommended action

Fax Send error. An error occurred while trying to send a fax. Try resending the fax.

Try faxing to another fax number.

Check for a dial tone on the phone line by
touching the Start Fax button.

Check that the telephone cord is securely
connected by unplugging and replugging the
cord.

Make sure that you are using the telephone
cord that came with the product.

Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.

Connect the product to a different phone
line.

Set the fax resolution to Standard instead of
the default of Fine.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

Fax storage is full.

Canceling the fax receive.

During the fax transmission, the product ran
out of memory. Only the pages that fit into
memory will be printed.

Print all of the faxes, and then have the
sender resend the fax. Have the sender
divide the fax job into multiple jobs before
resending. Cancel all fax jobs or clear the
faxes from memory.

Fax storage is full.

Canceling the fax receive.

The amount of available memory for storing
faxes is insufficient to store an incoming fax.

If you are using the Private Receive feature,
print all received faxes to regain some
memory.

If you still need more memory, clear faxes
from memory. Open the Service menu. In the
Fax Service menu, select the Clear Saved
Faxes option.

Fax storage is full.

Canceling the fax send.

During the fax job, the memory filled. All
pages of the fax have to be in memory for a
fax job to work correctly. Only the pages
that fit into memory were sent.

Cancel the current job. Turn the product off,
and then turn it on again. Try sending the
job again.

If the error reoccurs, cancel the job and turn
the product off and then on a second time.
The product might not have enough memory
for some jobs.
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Control panel message Description Recommended action

No dial tone. The product could not detect a dial tone. Check for a dial tone on the phone line by
touching the Start Fax button.

Unplug the telephone cord from both the
product and the wall and replug the cord.

Make sure that you are using the telephone
cord that came with the product.

Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.

Make sure that the phone cord from the wall

telephone jack is plugged into the line 

port.

Plug the product phone cord into a jack for
another phone line.

Check the phone line by using the Run Fax
Test option from the Service menu on the
control panel.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

No fax answer.

Canceled send.

Attempts to redial a fax number failed, or the
Redial if No Answer option was turned off.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

Check that the redial option is enabled.

Unplug the telephone cord from both the
product and the wall and replug the cord.

Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.

Make sure that the phone cord from the wall

telephone jack is plugged into the line 

port.

Plug the product phone cord into a jack for
another phone line.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.
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Control panel message Description Recommended action

No fax answer.

Redial pending.

The receiving fax line did not answer. The
product attempts to redial after a few
minutes.

Allow the product to retry sending the fax.

Call the recipient to ensure that the fax
machine is on and ready.

Check that you are dialing the correct fax
number.

If the product continues to redial, unplug the
product telephone cord from the wall, plug in
a telephone, and try making a voice call.

Make sure that the phone cord from the wall

telephone jack is plugged into the line 

port.

Plug the product phone cord into a jack for
another phone line.

Try a different phone cord.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

No fax detected. The product answered the incoming call but
did not detect that a fax machine was
calling.

Allow the product to retry receiving the fax.

Try a different phone cord.

Make sure that the phone cord from the wall

telephone jack is plugged into the line 

port.

Plug the product phone cord into a jack for
another phone line.

If the error persists, contact HP. See
www.hp.com/support/ljm425series or the
support flyer that came in the product box.

Solve problems sending faxes

● An error message displays on the control panel

● The control panel displays a Ready message with no attempt to send the fax

● The control panel displays the message "Storing page 1" and does not progress beyond that
message

● Faxes can be received, but not sent

● Product is password protected

● Unable to use fax functions from the control panel

● Unable to use speed dials
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● Unable to use group dials

● Receive a recorded error message from the phone company when trying to send a fax

● Unable to send a fax when a phone is connected to the product

An error message displays on the control panel

The Communication error. message appears

● Allow the product to retry sending the fax. Re-sending temporarily reduces the fax speed.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a call. Plug
the product phone cord into a jack for another phone line.

● Try a different phone cord.

● From the control panel, change the Fax Speed option to the Medium(V.17) setting or Slow(V.29)
setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction option.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: Turning off the Error Correction option can reduce image quality.

● If the error persists, contact HP. See www.hp.com/support/ljm425series or the support flyer that
came in the product box.

No dial tone.

● Make sure that the telephone cord is plugged into the correct port on the product.

● Make sure that the telephone cord from the product is plugged directly into the wall telephone
jack.

● Check for a dial tone on the phone line by using the Start Fax button.
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● Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice
call.

● Unplug the telephone cord from both the product and the wall and replug the cord.

● Make sure that you are using the telephone cord that came with the product.

● Plug the product phone cord into a jack for another phone line.

● Check the phone line by using the Run Fax Test option from the Service menu on the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Run Fax Test item.

The Fax is busy. message appears

● Try sending the fax again.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.

● Check for a dial tone on the phone line by using the Start Fax button.

● Make sure that the phone is working by disconnecting the product, plugging in a telephone to the
phone line, and making a voice call.

● Plug the product phone cord into a jack for another phone line, and try sending the fax again.

● Try a different phone cord.

● Send the fax at a later time.

● If the error persists, contact HP. See www.hp.com/support/ljm425series or the support flyer that
came in the product box.

The No fax answer. message appears

● Try to resend the fax.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a voice
call.

● Plug the product phone cord into a jack for another phone line.

● Try a different phone cord.

● Make sure that the phone cord from the wall telephone jack is plugged into the line  port.
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● Check the phone line by using the Run Fax Test option from the Service menu on the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Run Fax Test item.

● If the error persists, contact HP. See www.hp.com/support/ljm425series or the support flyer that
came in the product box.

Document feeder paper jam

● Verify that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

● Copy or print the original to letter, A4, or legal size paper, and then resend the fax.

The Fax storage is full. message appears

● Turn the product off then on.

● Print stored faxes that have not been printed.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Receive Options menu.

c. Select the Print Private Faxes item.

d. Provide the password when the product prompts you.

● Delete stored faxes from memory.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

● Divide the large fax job into smaller sections, and then fax them individually.

Scanner error

● Verify that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

● Copy or print the original onto letter, A4, or legal size paper and then resend the fax.
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The control panel displays a Ready message with no attempt to send the fax

● Check the fax activity log for errors.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If a phone is connected to the product, make sure that the phone is hung up.

● Disconnect all other lines between the fax and the product.

● Connect the product directly into the wall telephone jack and resend the fax.

The control panel displays the message "Storing page 1" and does not
progress beyond that message

● Delete stored faxes from memory.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

Faxes can be received, but not sent

Send fax and nothing happens.

1. Check for a dial tone on the phone line by using the Start Fax button.

2. Turn the product off then on.

3. Use the control panel or the HP Fax Setup Wizard to configure the fax time, date, and fax header
information.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Fax Header menu.

e. Enter the correct settings.

4. Verify that any extension phones on the line are hung up.

5. If using a DSL service, make sure that the phone line connection to the product includes a high-
pass filter.
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Product is password protected

If a network administrator has set a product password, then you must obtain the password in order to
use the product fax features.

Unable to use fax functions from the control panel

● The product might be password protected. Use the HP Embedded Web Server, HP Toolbox
software, or the control panel to set a password.

● If you do not know the password for the product, contact your system administrator.

● Verify with the system administrator that the fax functionality has not been disabled.

Unable to use speed dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

Unable to use group dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

● Set up all entries in the group with speed dial entries.

a. Open an unused speed dial entry.

b. Enter the fax number for the speed dial.

c. Touch the OK button to save the speed dial.
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Receive a recorded error message from the phone company when trying to
send a fax

● Make sure you dial the fax number correctly, and make sure that the phone service is not blocked.
For example, some phone services might prevent long distance calling.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

NOTE: To send a fax without a prefix, when the Dial Prefix option is turned on, send the fax
manually.

● Send a fax to an international number

a. If a prefix is required, manually dial the telephone number with the prefix.

b. Enter the country/region code before dialing the phone number.

c. Wait for pauses as you hear the tones on the phone.

d. Send the fax manually from the control panel.

Unable to send a fax when a phone is connected to the product

● Make sure that the telephone is hung up.

● Make sure that the telephone is not being used for a voice call when faxing.

● Unplug the phone from the line, and then try sending the fax.

Solve problems receiving faxes

● The fax does not respond

● An error message displays on the control panel

● A fax is received but does not print

● Sender receives a busy signal

● No dial tone

● Cannot send or receive a fax on a PBX line
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The fax does not respond

The fax has a dedicated phone line

● Set the Answer Mode option to the Automatic setting from the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Automatic setting.

An answering machine is connected to the product

● Set the Answer Mode option to the TAM setting and plug the answering machine into the
“telephone” port.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the TAM setting.

If the TAM setting is unavailable, set the Answer Mode option to the Automatic setting.

● Set the Rings to Answer setting to at least one ring more than the number of rings for which the
answering machine is set.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Rings to Answer menu.

e. Select the correct setting.

● Plug the answering machine into the “telephone” port.

● If the product has a telephone handset connected, set the Answer Mode option to the Fax/Tel
setting to route calls to the correct device. When detecting a voice call, the product generates a
ring tone that alerts you to pick up the telephone handset.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.
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c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Fax/Tel setting.

A telephone handset is connected to the product

Set the Answer Mode option to the Automatic setting.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the Fax Setup menu.

3. Open the Basic Setup menu.

4. Open the Answer Mode menu.

5. Select the Automatic setting.

The Answer Mode setting is set to the Manual setting

● Touch the Start Fax button on the product control panel.

Voice mail is available on the fax line

● Add a distinctive ring service to your telephone line and change the Distinctive Ring setting on the
product to match the ring pattern supplied by the telephone company. Contact your telephone
company for information.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Distinctive Ring menu.

e. Select the correct setting.

● Buy a dedicated line for faxing.

● Set the Answer Mode option to the Manual setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Manual setting.

NOTE: You must be present to receive faxes.
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The product is connected to a DSL phone service

● Check the installation and features. A DSL modem requires a high-pass filter on the phone line
connection to the product. Contact your DSL service provider for a filter or buy a filter.

● Verify that the filter is plugged in.

● Replace the existing filter to make sure that it is not defective.

The product uses a fax over IP or VoIP phone service

● Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting, or disable the Fast(V.34)
setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Contact your service provider to make sure that fax is supported and for a recommended fax
speed settings. Some companies might require an adapter.

An error message displays on the control panel

The No fax detected. message appears

NOTE: This error does not always refer to a missed fax. If a voice call is made to a fax number by
mistake and the caller hangs up, the No fax detected. message appears on the control panel.

● Ask the sender to resend the fax.

● Make sure that the telephone cord from the product is plugged into the wall telephone jack.

● Try a different phone cord.

● Plug the product phone cord into a jack for another phone line.

● Make sure the telephone line and phone wall jack are active by plugging in a telephone and
checking for a dial tone.

● Make sure that the telephone cord is plugged into the “line” port on the product.

● Check the phone line by running a fax test from the control panel.

● If the error persists, contact HP. See www.hp.com/support/ljm425series or the support flyer that
came in the product box.
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The Communication error. message appears

● Ask the sender to send the fax again or send at a later time when line conditions have improved.

● Unplug the product telephone cord from the wall, plug in a telephone, and try making a call. Plug
the product phone cord into a jack for another phone line.

● Try a different phone cord.

● Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting, or disable the Fast(V.34)
setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction feature to prevent automatic error correction.

NOTE: Turning off the Error Correction feature can reduce image quality.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

● Print the Fax Activity Log report from the control panel to determine if the error occurs with a
specific fax number.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If the error persists, contact HP. See www.hp.com/support/ljm425series or the support flyer that
came in the product box.

The Fax storage is full. message appears

● Turn the product off then on.

● Print all of the faxes, and then have the sender resend the fax.

● Ask the sender to divide a large fax job into smaller sections, and then fax them individually.
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● Make sure that the resolution of the sending fax machine is not set to the Photo setting or the
Superfine setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

● Cancel all fax jobs or clear the faxes from memory.

The Fax is busy. message appears

● The product cannot receive a fax while attempting to send one. Cancel the fax send and try
sending at a later time.

● Allow the product to try sending the fax again.

A fax is received but does not print

The Private Receive feature is on

● When the Private Receive feature is activated, received faxes are stored in memory. A password is
required to print the stored faxes.

● Enter the password to print the fax. If you do not know the password, contact the product
administrator.

NOTE: Memory errors might occur if the faxes are not printed. The product will not answer if the
memory is full.

Sender receives a busy signal

A handset is connected to the product

● Make sure the phone is hung up.

● Change the Answer Mode option to match the product setup.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the setting that matches the product setup.
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Set the Answer Mode option to the Fax/Tel setting to automatically receive faxes. The Fax/
Tel setting automatically detects whether the incoming transmission is a fax or a voice call
and routes the call to the appropriate device.

A phone line splitter is being used

● If you are using a phone line splitter, remove the splitter and set up the phone as a downstream
phone.

● Make sure the phone is hung up.

● Make sure the phone is not being used for a voice call when faxing.

No dial tone

● If using a phone line splitter, remove the phone line splitter and set up the phone as a downstream
phone.

Cannot send or receive a fax on a PBX line

● If you are using a PBX phone line, contact your PBX administrator to configure an analog fax line
for your product.

Solve general fax problems 

● Faxes are sending slowly

● Fax quality is poor

● Fax cuts off or prints on two pages

Faxes are sending slowly

The product is experiencing poor phone line quality.

● Retry sending the fax when the line conditions have improved.

● Check with the phone service provider that the line supports fax.

● Turn off the Error Correction setting.

a. Open the Setup Menu menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: This can reduce image quality.

● Use white paper for the original. Do not use colors such as gray, yellow, or pink.
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● Increase the Fax Speed setting.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Divide large fax jobs into smaller sections, and then fax them individually.

● Change the fax settings on the control panel to a lower resolution.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

Fax quality is poor

Fax is blurry or light.

● Increase fax resolution when sending faxes. Resolution does not affect received faxes.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

NOTE: Increasing resolution slows transmission speed.

● Turn on the Error Correction setting from the control panel.

a. Open the Setup Menu menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the On setting.
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● Check the toner cartridges and replace if necessary.

● Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.

Fax cuts off or prints on two pages

● Set the Default Paper Size setting. Faxes print on a single size of paper based on the Default
Paper Size settings.

a. Open the Setup Menu menu.

b. Open the System Setup menu.

c. Open the Paper Setup menu.

d. Open the Default Paper Size menu.

e. Select the correct setting.

● Set the paper type and size for the tray used for faxes.

● Turn on the Fit to Page setting to print longer length faxes on letter or A4 size paper.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fit to Page menu.

e. Select the On setting.

NOTE: If the Fit to Page setting is off and the Default Paper Size setting is set to letter, a legal size
original prints on two pages.
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7 Manage and maintain

● Use the HP Reconfiguration Utility to change the product connection

● Set up HP Wireless Direct Printing

● Use HP Web Services applications

● Configure IP network settings

● HP Device Toolbox (Windows)

● HP Utility for Mac OS X

● HP Web Jetadmin

● Product security features

● Economy settings

● Print when a toner cartridge is at estimated end of life

● Store and recycle supplies

● Replacement instructions

● Memory

● Update the firmware
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Use the HP Reconfiguration Utility to change the
product connection

If you are already using the product and you wish to change the way it is connected, use the
HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use
a different wireless address, to connect to a wired or wireless network, or change from a network
connection to a USB connection. You can change the configuration without inserting the product CD.
After you select the type of connection you wish to make, the program goes directly to the portion of
the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
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Set up HP Wireless Direct Printing
NOTE: This feature is available with wireless models only.

The HP Wireless Direct Printing feature lets you print from your wireless mobile device directly to an
HP Wireless Direct-enabled product without requiring connection to an established network or the
Internet. Use HP Wireless Direct to print wirelessly from the following devices:

● iPhone, iPad, or iTouch using Apple AirPrint

● Mobile devices that run Android, iOS, or Symbian using the HP ePrint Home & Biz application

To set up HP Wireless Direct from the control panel, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Network Setup

● Wireless Menu

● Wireless Direct Settings

● Wireless Direct On/Off

NOTE: If the Wireless Direct Settings item does not appear on the control panel, you need to
upload the current version of the product firmware. To get the current version, go to www.hp.com,
enter the HP product number in the search box, select the specific product model, and then click
the Software & Driver Downloads link.

3. Touch the On menu item. The product saves the setting and then returns the control panel to the
Wireless Direct Settings menu.
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Use HP Web Services applications
1. From the Home screen on the product control panel, touch the Web Services  button.

2. Touch the Enable Web Services button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu
on the product control panel. This process enables both HP Web Services and the Apps menu.
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Configure IP network settings

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

1. From the Home screen on the product control panel, touch the Network  button to find the

product IP address.

2. To open the HP Embedded Web Server, type the IP address into the address line of a Web
browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the TCP/IP Config menu, and then touch the Manual button.

4. Use the numeric keypad to enter the IP address, and touch the OK button. Touch the Yes button to
confirm.

5. Use the numeric keypad to enter the subnet mask, and touch the OK button. Touch the Yes button
to confirm.

6. Use the numeric keypad to enter the default gateway, and touch the OK button. Touch the Yes
button to confirm.

Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the
HP Embedded Web Server.

1. From the Home screen on the product control panel, touch the Network  button to find the

product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Open the System tab.
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4. On the Device Information page, the default product name is in the Device Status field. You
can change this name to uniquely identify this product.

NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.
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Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings
might prevent the product from communicating with other network devices. If you need to make
changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network hub,
switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the Link Speed menu.

4. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Full 10 Mbps, full-duplex operation

10T Half 10 megabytes per second (Mbps), half-duplex operation

100TX Full 100 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

5. Touch the OK button. The product turns off and then on.
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HP Device Toolbox (Windows)
Use the HP Device Toolbox for Windows to view or change product settings from your computer. This
tool opens the HP Embedded Web Server for the product.

NOTE: This tool is available only if you performed a full installation when you installed the product.

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Tab or section Description

Home tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the approximate percent life
remaining of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies.
Actual supply life remaining can vary. Consider having a replacement supply
available to install when print quality is no longer acceptable. The supply does not
need to be replaced unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration
page.

● Network Summary: Shows the information found on the product network
configuration page.

● Reports: Allows you to print the configuration and supplies status pages that the
product generates.

● Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product,
including calibration settings.

● Paper Types: Allows you to configure print modes that correspond to the paper
types that the product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set or change the product password.

● Save and Restore: Save the current settings for the product to a file on the
computer. Use this file to load the same settings onto another product or to restore
these settings to this product at a later time.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the administrator before changing settings on this tab.
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Tab or section Description

Print tab

Provides the ability to change
default print settings from your
computer.

● Printing: Change the default product print settings, such as number of copies and
paper orientation. These are the same options that are available on the control
panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: Turn off or on the Print PS Errors feature.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the product
when it is connected to an IP-based network. It also allows the network administrator to
set up Wireless Direct functionality. This tab does not appear if the product is directly
connected to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.

HP Smart Install tab Use this tab to download and install the print driver.
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to view or change product settings from your computer. This tool opens
the HP Embedded Web Server for the product.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-
based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Change the Bonjour name for the product on the Bonjour network.

● Display the color usage page.
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HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to
learn more about updates.

NOTE: Device plug-ins can be installed into HP Web Jetadmin to provide support for specific product
features.

NOTE: Browsers must be Java-enabled. Web Jetadmin is not supported for Mac OS X.
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Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

 

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on
a network.

1. From the Home screen on the product control panel, touch the Network  button to find the

product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Settings tab, and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

4. Type the new password in the New Password box and in the Verify password box.

5. At the bottom of the window, click the Apply button to save the password.
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Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web
Server

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the sleep delay

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep Delay

3. Select the time for the sleep delay.

NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Power Down Delay
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3. Select the time for the power-down delay.

NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when
you press a button on the control panel. You can change which events cause the product to wake.
Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Wake Events

To turn off a wake event, select the event and then select the No option.
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Print when a toner cartridge is at estimated end of
life

Black Low: The product indicates when a toner cartridge level is low. Actual toner cartridge life
remaining may vary. Consider having a replacement available to install when print quality is no longer
acceptable. The toner cartridge does not need to be replaced now.

Black Very Low: The product indicates when the toner cartridge level is very low. Actual toner
cartridge life remaining may vary. Consider having a replacement available to install when print
quality is no longer acceptable. The toner cartridge does not need to be replaced now unless the print
quality is no longer acceptable.

Once an HP toner cartridge has reached “very low”, HP’s Premium Protection Warranty on that toner
cartridge has ended.

You can change the way the product reacts when supplies reach the Very Low state. You do not have
to re-establish these settings when you install a new toner cartridge.

Enable or disable the At Very Low settings

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new toner cartridge.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge

● Very Low Setting

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the toner cartridge is very low,
but to continue printing.

● Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the toner cartridge.

● Select the Prompt option to set the product to stop printing (including printing faxes) and
prompt you to replace the toner cartridge. You can acknowledge the prompt and continue
printing. A customer configurable option on this product is "Prompt to Remind Me in 100
pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer
convenience and is not an indication these pages will have acceptable print quality.

When the product is set to the Stop option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while stopped.
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When the product is set to the Prompt option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while the
product is waiting for the prompt to be acknowledged.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner
cartridge has ended. All print defects or cartridge failures incurred when an HP toner cartridge is used
in Continue at very low mode will not be considered to be defects in materials or workmanship in the
toner cartridge under the HP Print Cartridge Warranty Statement.
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Store and recycle supplies

Recycle supplies

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Toner cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few
minutes.
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Replacement instructions

Change the toner cartridge

When a toner cartridge approaches the end of useful life, you are prompted to order a replacement.
You can continue printing with the current cartridge until redistributing the toner no longer yields
acceptable print quality.

1. Open the toner cartridge door, and then
remove the toner cartridge.

 

2. Remove the new toner cartridge from the bag.
Place the used toner cartridge in the bag for
recycling.
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3. Grasp both sides of the toner cartridge and
distribute the toner by gently rocking the
cartridge.

CAUTION: Do not touch the shutter or the
surface of the roller.

 

4. Bend the tab on the left side of the cartridge
until the tab breaks loose. Pull the tab until all
the tape is removed from the cartridge. Place
the tab and tape in the toner cartridge box to
return for recycling.

 

5. Align the toner cartridge with the tracks inside
the product, insert the toner cartridge until it is
firmly seated, and then close the toner
cartridge door.

 

6. Installation is complete. Place the used toner
cartridge in the box in which the new cartridge
arrived. See the enclosed recycling guide for
recycling instructions.
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Memory
This product includes a memory panel that will accept the following third-party font and barcode
memory modules. Hewlett-Packard does not sell these products.

● BarDIMM Pro, Jetmobile

● MicrDIMM Pro, Jetmobile

● TypeHaus Fonts and Barcodes Solutions, TypeHaus, Inc.

● Asian Fonts, JITCO, Ltd.

● BarDIMM® Box, Jetmobile

● BarSIMM 1.9, Jetmobile

● EIO Hard-Disk for LaserJet Series, Oberon Service SRL

● Ethernet to Token Ring Router (ETRR), Ringdale

● EuroForm Barcode 100, EuroForm A/S

CAUTION: Handling a memory module without wearing a grounded, antistatic device might
damage the module. Touch any metal part of the product or other grounded metal before touching the
memory module.
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Update the firmware
HP offers periodic upgrades to the product firmware. You can load the firmware updates manually, or
you can set the product to automatically load firmware updates.

Manually update the firmware

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Check For Updates Now

3. Touch the Yes button to prompt the product to search for firmware updates. If the product detects
an upgrade, it will begin the update process.

Set the product to automatically update the firmware

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Manage Updates

● Prompt Before Install

3. Touch the Install Automatically option.
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8 Solve problems

● Solve problems checklist

● Restore the factory-set defaults

● Control panel help system

● Interpret control panel messages

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● Solve copy quality problems

● Solve scan quality problems

● Solve scan to email problems

● Solve scan to network folder problems

● Solve fax quality problems

● The product does not print or it prints slowly

● Solve walk-up USB printing problems

● Solve direct connection problems

● Solve wired network problems

● Solve wireless network problems

● Solve product software problems with Windows

● Solve product software problems with Mac OS X

● Remove software (Windows)

● Remove software (Mac OS X)
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection

● Step 3: Check the control panel for error messages

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Test copy functionality

● Step 8: Check the toner cartridge

● Step 9: Try sending a print job from a computer

● Step 10: Verify that the product is on the network

Step 1: Make sure that the product is set up correctly

1. Press the power button to turn on the product or to deactivate the Auto Power Down mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label on
the back of the product for voltage requirements.) If you are using a power strip and its voltage is
not within specifications, plug the product directly into the wall. If it is already plugged into the
wall, try a different outlet.

4. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection

1. Check the cable connection between the product and the computer. Make sure that the connection
is secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

3. If the product is connected to a network, check the following items:

● Check the light next to the network connection on the product. If the network is active, the
light is green.

● Make sure that you are using a network cable and not a phone cord to connect to the
network.
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● Make sure the network router, hub, or switch is turned on and that it is working correctly.

● If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

4. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the print driver for this product. Check the program to make sure that
you are using the print driver for this product.

Step 6: Test print functionality

1. Print a configuration page.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Test copy functionality

1. Place the configuration page onto the capture stage and make a copy.

2. If the print quality on the copied pages is not acceptable, clean the cover over the camera lens
with a soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the capture stage. They might seep and damage the product.

Step 8: Check the toner cartridge

Print a supplies status page and check remaining life of the toner cartridge.

ENWW Solve problems checklist 153



Step 9: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the
software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the media that you
are using.

Step 10: Verify that the product is on the network

For networked products, open a Web browser, type the product IP address (from the previously printed
configuration page) in the address box, and then press the Enter button to open the HP Embedded
Web Server. If the HP EWS does not open, reinstall the product on the network.
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Restore the factory-set defaults 
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It
will not reset the page count, tray size, or language. To restore the product to the factory-default
settings, follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it
also deletes any pages that are stored in the memory. The procedure then automatically restarts the
product.

1. On the product control panel, touch the Setup  button.

2. Scroll to and touch the Service menu.

3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
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Control panel help system
The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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Interpret control panel messages

Control panel message types

The control panel messages indicate the current product status or situations that might require action.

Alert and warning messages appear temporarily and might require you to acknowledge the message
by pressing the OK button to resume or by pressing the Cancel  button to cancel the job. With
certain warnings, the job might not complete or the print quality might be affected. If the alert or
warning message is related to printing and the auto-continue feature is on, the product will attempt to
resume the printing job after the warning has appeared for 10 seconds without acknowledgement.

Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

Control panel messages

49 Error, Turn off then on

Description

The product experienced an internal error.

Recommended action

Turn the product off, wait at least 30 seconds, and then turn the product on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

50.x Fuser Error

Description

The product has experienced an error with the fuser.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

Turn off the product, wait at least 25 minutes, and then turn on the product.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

ENWW Interpret control panel messages 157



51.XX Error

Description

The product has experienced an internal hardware error.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product on.

If the message persists, contact HP support.

54.XX Error

Description

The product has experienced an error with one of the internal sensors.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

55.X Error

Description

The product has experienced an internal error.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

57 Fan Error, Turn off then on

Description

The product has experienced a problem with its internal fan.
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Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

59.X Error

Description

The product has experienced a problem with one of the motors.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

79 Error Turn off then on

Description

The product has experienced an internal firmware error.

Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for
it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the
product power on.

If the message persists, contact HP support.

79 Service error

Description

An incompatible DIMM is installed.

Recommended action

1. Turn the product power off.

2. Install a DIMM that the product supports.

3. Turn the product on.
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If the message persists, contact HP support.

Black cartridge low

Description

The toner cartridge is nearing the end of its useful life.

Recommended action

Printing can continue, but consider having a replacement toner cartridge on hand.

Black cartridge very low

Description

The toner cartridge is at the end of its useful life. A customer configurable option on this product is
"Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This option is
provided as a customer convenience and is not an indication these pages will have acceptable print
quality.

Recommended action

To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP toner cartridge has reached very low, HP's Premium Protection Warranty on that toner
cartridge has ended. All print defects or cartridge failures incurred when an HP toner cartridge is used
in continue at very low mode will not be considered to be defects in materials or workmanship in the
toner cartridge under the HP Print Cartridge Warranty Statement.

Cleaning

Description

The product periodically performs a cleaning procedure to maintain the best print quality.

Recommended action

Wait for the cleaning process to finish.

Device error, press OK

Description

An internal error occurred.

Recommended action

Press the OK button to resume the job.
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Door open

Description

The product front door is open.

Recommended action

Close the door.

Genuine HP supply installed

Description

A genuine HP toner cartridge was installed.

Recommended action

No action necessary.

Incompatible black

Description

You have installed a toner cartridge that is intended for use in a different HP product model. The
product might not function correctly with this toner cartridge installed.

Recommended action

Install the correct toner cartridge for this product.

Install black cartridge

Description

The toner cartridge is either not installed or not correctly installed in the product.

Recommended action

Install the toner cartridge.

Invalid driver Press [OK]

Description

You are using an incorrect print driver.

Recommended action

Select the correct print driver.
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Jam in Tray 1, Clear jam and then press OK

Description

The product has detected a jam.

Recommended action

Clear the jam from the tray, and then press OK.

If the message persists, contact HP support.

Load Tray 1 <TYPE> <SIZE>, Press OK to use available media

Description

The tray is not configured for the paper type and size that the print job is requesting.

Recommended action

Load the correct paper into Tray 1. Or press the OK button to use the paper currently in the tray.

Load Tray 1, <PLAIN> <SIZE> / Cleaning mode, OK to start

Description

The product is ready to process the cleaning operation.

Recommended action

Load Tray 1 with plain paper in the size indicated, and then press the OK button.

Load tray <X> Press [OK] for available media

Description

The tray is empty.

Recommended action

Load paper into the tray to continue printing. Press the OK button to select a different tray.

Load tray <X> <TYPE> <SIZE>

Description

A tray is configured for the paper type and size that the print job is requesting, but that tray is empty.

Recommended action

Load the correct paper into the tray, or press the OK button to use paper in a different tray.
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Manual Duplex Load Tray 1, Press OK

Description

The first side of a manual duplex job has printed, and the page needs to be loaded to process the
second side.

Recommended action

Load the page in the indicated tray with the side to be printed face up, and the top of the page away
from you and then press the OK button.

Manual feed <SIZE> <TYPE>, Press OK to use available media

Description

The product is set for manual feed mode.

Recommended action

Press the OK button to clear the message or load the correct paper into Tray 1.

Memory is low. Press OK.

Description

The product memory is almost full.

Recommended action

Press the OK button to finish the job, or press the Cancel  button to cancel the job.

Break the job into smaller jobs that contain fewer pages.

Misprint, Press OK

Description

Paper has been delayed as it moves through the product.

Recommended action

Press the OK button to clear the message.

To avoid this problem, try the following solutions:

1. Adjust the paper guides in the tray. Make sure the front paper guide is pushing the paper against
the back edge of the tray.

2. Use paper that meets HP specifications. Store paper unopened in its original packaging.

3. Use the product in an area that meets the environmental specifications for this product.
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Print failure, press OK. If error repeats, turn off then on.

Description

The product cannot process the page.

Recommended action

Press the OK button to continue printing the job, but output might be affected.

If the error persists, turn the power off and then on. Resend the print job.

Rear door open

Description

The product rear door is open.

Recommended action

Close the door.

Remove shipping material from toner cartridge

Description

A toner cartridge shipping lock is installed.

Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Replace black cartridge

Description

The toner cartridge is at the end of its useful life, and the product is customer-configured to stop printing
when it reaches the very low state.

Recommended action

To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can
continue printing until you notice a decrease in print quality. Actual cartridge life may vary. Once an
HP toner cartridge has reached very low, HP's Premium Protection Warranty on that toner cartridge has
ended. All print defects or cartridge failures incurred when an HP toner cartridge is used in Continue at
Very Low mode will not be considered to be defects in materials or workmanship in the toner cartridge
under the HP Print Cartridge Warranty Statement.

Unexpected size in tray <X> Load <size> Press [OK]

Description

The product has detected paper in the tray that does not match the configuration for the tray.
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Recommended action

Load the correct paper into the tray, or configure the tray for the size that you have loaded.

Unsupported black cartridge Press [OK] to continue

Description

The product has detected an installed toner cartridge that was not made by HP.

Recommended action

Press the OK button to continue printing.

If you believe you purchased an HP supply, go to www.hp.com/go/anticounterfeit. Service or repairs
that are required as a result of using unsupported supplies are not covered under HP warranty.

Used black cartridge is installed Press [OK] to continue

Description

You are using a toner cartridge that reached the default low threshold while it was installed in a
product.

Recommended action

Prining can continue, but consider having a replacement toner cartridge on hand.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams

Jam locations

Jams can occur in these locations:

5

6

1 Document feeder

2 Output bin

3 Rear door

4 Tray 1

5 Tray 2

6 Optional Tray 3

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.
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Clear jams from the document feeder

1. Turn the product off.  

2. Open the document feeder cover.  

3. Gently pull the jammed paper out.  
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4. Close the document feeder roller assembly,
and then close the document feeder cover.

 

5. Open the scanner lid. If paper is jammed in
the scanner lid, gently pull it out.

 

Clear a jam in Tray 1

NOTE: If the sheet tears, remove all fragments before resuming printing.

ENWW Clear jams 169



1. If you can see the jammed sheet, remove the
jammed sheet by pulling it straight out.

 

2. If you cannot see the jammed sheet, open the
print cartridge door, and then remove the print
cartridge.

 

170 Chapter 8   Solve problems ENWW



3. Remove the jammed sheet by pulling it straight
out.

CAUTION: Do not pull up on the jammed
sheet. Be sure to pull it straight out.

 

4. Reinstall the print cartridge, and then close the
print cartridge door.

 

Clear a jam in Tray 2 

1. Remove the tray from the product.  
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2. Remove the jammed sheet by pulling it straight
out.

 

3. Replace the tray.  

4. Press the OK button to continue printing.  
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Clear a jam in optional Tray 3

1. Remove the tray from the product.  

2. Remove the jammed sheet by pulling it straight
out.

 

3. Replace the tray.  

4. Press the OK button to continue printing.  

ENWW Clear jams 173



Clear jams from the output bin

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

1. With both hands, grasp the paper, and
carefully pull it free from the product.

 

Clear a jam in the duplexer area

1. Open the rear door.  
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2. Remove any jammed sheets.

NOTE: If the sheet tears, remove all
fragments before resuming printing.

CAUTION: Wait until the fuser area has
cooled before clearing the jam.

 

3. Close the rear door.  

Clear a jam in the fuser area

1. Open the rear door.  
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2. Remove any jammed sheets.

NOTE: If the sheet tears, remove all
fragments before resuming printing.

CAUTION: Wait until the fuser area has
cooled before clearing the jam.

 

3. Close the rear door.  
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Improve print quality

Check the paper type setting (Windows)

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and then click the OK button.

Check the paper type setting (Mac OS X)

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

5. Open the Finishing menu.
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6. Select a type from the Media-type drop-down list.

7. Click the Print button.

Check toner cartridge status

Print the supplies status page

Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System Setup menu on the control panel or the embedded Web server.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Reports button.

3. Touch the Supplies Status button to print the report.

Check the supplies status

Check the supplies status page for the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Print a cleaning page

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

The product prints the first side and then prompts you to remove the page from the output bin and
reload it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the
page that prints.
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Inspect the toner cartridge for damage

1. Remove the toner cartridge from the product,
and verify that the sealing tape has been
removed.

 

2. Check the memory chip for damage.  

3. Examine the surface of the imaging drum on
the bottom of the toner cartridge.

CAUTION: Do not touch the roller (imaging
drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause
print-quality problems.

 

4. If you see any scratches, fingerprints, or other
damage on the imaging drum, replace the
toner cartridge.

 

5. If the imaging drum does not appear to be
damaged, rock the toner cartridge gently
several times and reinstall it. Print a few pages
to see if the problem has resolved.
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Check the paper and printing environment

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the product environment

Verify that the product is operating within the environmental specifications listed in the product
Warranty and Legal Guide.

Check print job settings

Check the EconoMode setting

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner. However, using EconoMode can also reduce print quality. To improve print quality, verify that
the EconoMode setting is deactivated.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Verify that the EconoMode check box is cleared. If there is a checkmark in the check box, click
the check box to clear it.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.
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Use the print driver that best meets your printing needs

You might need to use a different print driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● May not be fully compatible with third-party and custom solutions based on
PCL5

Download additional print drivers from this Web site: www.hp.com/support/ljm425series.
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Solve copy quality problems

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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Check the paper settings

1. From the Home screen on the product control
panel, touch the Copy button.

 

2. Touch the Settings button, and then scroll to
and touch the Paper button.

 

3. From the list of paper sizes, touch the name of
the paper size that is in Tray 1.

 

4. From the list of paper types, touch the name of
the paper type that is in Tray 1.

 

5. Touch the Black or Color button to start
copying.

 

Optimize for text or pictures

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.
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1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  

Edge-to-edge copying

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x
13.7 in), leaving a 4 mm unprintable border around the page.

Considerations for printing or scanning documents with cropped edges:

● When the original is smaller than the output size, move the original 4 mm (1/6 inch) away from
the corner indicated by the icon on the scanner. Recopy or scan in this position.

● When the original is the size of the desired output, use the Reduce/Enlarge feature to reduce the
image so the copy is not cropped.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document feeder rollers and separation pad.
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1. Open the document feeder cover.  

2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document feeder cover.  
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Solve scan quality problems

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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Check the resolution settings

The following table describes the recommended resolution and color settings for different types of scan
jobs.

NOTE: The default resolution is 200 ppi.

Intended use Recommended resolution Recommended color settings

Fax 150 ppi ● Black and white

Email 150 ppi ● Black and white, if the image does not require
smooth gradation

● Grayscale, if the image requires smooth gradation

● Color, if the image is in color

Edit text 300 ppi ● Black and white

Print (graphics or text) 600 ppi for complex graphics, or if
you want to significantly enlarge the
document

300 ppi for normal graphics and text

150 ppi for photos

● Black and white for text and line art

● Grayscale for shaded or colored graphics and
photos

● Color, if the image is in color

Display on screen 75 ppi ● Black and white for text

● Grayscale for graphics and photos

● Color, if the image is in color

Check the color settings

You can set the color values to the following settings when scanning.

Setting Recommended use

Color Use this setting for high-quality color photos or documents in which the color is important.

Black and White Use this setting for text documents.

Grayscale Use this setting when file size is an issue or when you want to scan a document or
photograph quickly.

Optimize for text or pictures

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.
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● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document feeder rollers and separation pad.

1. Open the document feeder cover.  
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2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document feeder cover.  
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Solve scan to email problems
If scan to email problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Email feature is enabled. If it has been disabled, enable the feature through
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a computer or to a network.

Cannot connect to the email server

● Make sure the SMTP server name is correct. Check this setting with your system administrator or
Internet Service Provider.

● If the product cannot establish a secure connection to the SMTP server, try without the secure
connection or try a different server or port. Check this setting with your system administrator or
Internet Service Provider.

● If the SMTP server requires authentication, make sure a valid user name and password are used.

● If the SMTP server uses an authentication method that is not supported, try a different server.
Check this setting with your system administrator or Internet Service Provider.

The email failed

● Verify that email addresses entered are correct.

● If the size of the email was too large, send fewer pages or reduce the scan resolution.

Unable to scan

● If you are prompted for a PIN, enter the correct PIN for the outgoing profile.

● Make sure at least one email address is selected in the To field.
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Solve scan to network folder problems
If scan to network folder problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Network Folder feature is enabled. If it has been disabled, enable the
feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a network.

The scan failed

● Make sure the network path is in the correct format (//host/share/path) and the folder exists.

● Make sure the network directory is readable and writeable.

● If you are using the default file names for scanned files, make sure there are no conflicting file
names. Remove some of the previously scanned files.

● Use the IP address instead of the host name. Make sure the product and host are connected to the
same network.

● If the network folder is password protected, make sure to enter the correct user name and
password.

● If a Disk full message displays, remove some files from the network folder.

● Turn the product off, and then on. Scan again.
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Solve fax quality problems

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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Check the send-fax resolution setting

If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Open the Fax Resolution menu.

Optimize for text or pictures

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  
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Check the error correction setting

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Send to a different fax machine

Send the fax job to a different fax machine to see if another machine will successfully receive the fax
job.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document feeder rollers and separation pad.

1. Open the document feeder cover.  
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2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document feeder cover.  

Check the fit-to-page setting

If the product printed a fax job off the page, turn on the fit-to-page feature from the product control
panel.

NOTE: Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Check the sender's fax machine

Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.
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Perform a fax diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
product fax settings.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus

● System Setup

● Self Diagnostics

3. Touch the Run Fax Test button to start the test. The product prints a test page that shows test results.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic print drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/ljm425series.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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Solve walk-up USB printing problems
● The USB Flash Drive menu does not open when you insert the USB accessory

● The file does not print from the USB storage accessory

● The file that you want to print is not listed in the USB Flash Drive menu

The USB Flash Drive menu does not open when you insert the USB
accessory

1. You might be using a USB storage accessory or a file system that this product does not support.
Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory
manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat
the USB storage accessory to remove the partitions, or use a different USB storage accessory.

4. The USB storage accessory might require more power than the product can provide.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the USB Flash Drive
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .PDF and .JPEG file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve direct connection problems
If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft
operating systems and not of the HP print drivers. For more information, go to Microsoft at
www.microsoft.com.

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the
network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

Wireless connectivity checklist

● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure that
the wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the
SSID. If you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network.
If the network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless
access point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the product
must be within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the
access point and the product. Make sure poles, walls, or support columns containing metal or
concrete do not separate the product and wireless access point.

● Verify that the product is located away from electronic devices that might interfere with the
wireless signal. Many devices can interfere with the wireless signal including motors, cordless
phones, security system cameras, other wireless networks, and some Bluetooth devices.

● Verify that the print driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and product connect to the same wireless network.

● For Mac OS X, verify that the wireless router supports Bonjour.

The product does not print after the wireless configuration
completes

1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.

5. Verify that you can open the product HP Embedded Web Server from a computer on the network.
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The product does not print, and the computer has a third-party
firewall installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless
router or product

1. Make sure that the router or product connects to the same network that your computer connects to.

2. Print a configuration page.

3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for the computer.

4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the
signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a
VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

ENWW Solve wireless network problems 205



The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the router IP address.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.

Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
wireless network settings.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus

● System Setup

● Self Diagnostics

3. Touch the Run Network Test button to start the test. The product prints a test page that shows test
results.
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Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt
radio signals.

● Keep the wireless devices away from large masonry structures and other building structures. These
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Solve product software problems with Windows

A print driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use
one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista

a. Click Start.

b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Right-click the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.

f. Verify the IP address, and then click OK or Cancel.

g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Solve product software problems with Mac OS X
● The print driver is not listed in the Print & Fax or Print & Scan list

● The product name does not appear in the product list in the Print & Fax or Print & Scan list

● The print driver does not automatically set up the selected product in the Print & Fax or Print &
Scan list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan
list after the driver is selected.

● You are using a generic print driver when using a USB connection

The print driver is not listed in the Print & Fax or Print & Scan list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print &
Fax or Print & Scan list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

3. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

4. Replace the USB or network cable with a high-quality cable.

The print driver does not automatically set up the selected product
in the Print & Fax or Print & Scan list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

5. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

When connected with a USB cable, the product does not appear in
the Print & Fax or Print & Scan list after the driver is selected.

Software troubleshooting

1. Make sure that your Mac operating system is Mac OS X 10.5 or later.

2. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate Hi-Speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and then connect the cable directly to the USB port on the
computer.

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic print driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic print
driver instead of the driver for this product.

1. Delete the generic print driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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Remove software (Windows)

Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

212 Chapter 8   Solve problems ENWW



Remove software (Mac OS X)
You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Select Hewlett Packard.

4. Select HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.
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9 Supplies and accessories

● Order parts, accessories, and supplies

● HP policy on non-HP supplies

● HP anticounterfeit Web site
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Order parts, accessories, and supplies

HP original toner cartridge and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Item Part number Cartridge number Description

HP LaserJet toner cartridge CF280A (standard)

CF280X (extended)

80A

80X

Black toner cartridge

Input tray CF284A  500-sheet Tray 3

USB 2.0 printer cable C6518A  (2-meter standard) A-to-B cable

HP policy on non-HP supplies
Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or
remanufactured.

NOTE: For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does
not affect either the warranty to the customer or any HP support contract with the customer. However, if
product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.

HP anticounterfeit Web site
Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the toner cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Index

A
accessories

ordering 215, 216
AirPrint 51
answer mode, setting 87
answering machines, connecting

fax settings 88
anticounterfeit supplies 216
applications

downloading 132
Apps menu 132
archival-quality printing 49
autoreduction settings, fax 90

B
billing codes, fax

using 85
bin, output

locating 2
bins, output

jams, clearing 174
blocking faxes 88
booklets

printing (Mac) 44
printing (Windows) 39

busy signals, redialing options 83

C
camera, locating 2
canceling

faxes 93
print job (Mac) 47
print job (Windows) 45

capture stage, locating 2
cartridge

part numbers 216
replacing 146
supplies status page 6

cartridges
non-HP 216
recycling 145
storage 145

checklist
fax troubleshooting 105

cleaning
glass 182, 186, 192
paper path 178

collating copies 57
configuration page 6
contrast settings

copy 62
fax 84

control panel
buttons and lights 4
help 156
Home screen 4
locating 2
menu map, printing 6
message types 157
messages, troubleshooting

157
Reports menu 6

copying
collation 57
contrast, adjusting 62
double-sided 58
draft mode 63
enlarging 59
light/dark settings 62
multiple copies 55
multiple-page originals 56
paper size and type 64
quality, adjusting 61
reducing 59
restore default settings 66
set new default settings 65
single copies 54

counterfeit supplies 216
custom-size copies 59

D
darkness, contrast settings

copy 62
fax 84

default copy settings
changing 65
restoring to factory settings 66

default gateway, setting 133
defaults, restoring 155
delaying fax sending 100
deleting faxes from memory 93
dial tone detection settings 82
dialing

from a telephone 100
pauses, inserting 82
prefixes, inserting 82
redialing automatically,

settings 83
tone or pulse settings 83

distinctive-ring settings 89
document feeder

jams 168
door release, locating 2
dots per inch (dpi)

fax 84
dpi (dots per inch)

fax 84
draft mode, copying 63
drivers

changing settings (Mac) 24
changing settings (Windows)

22
presets (Mac) 41
settings (Mac) 41
usage page 6
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DSL
faxing 94

duplex printing (double-sided)
manual settings (Windows) 30

duplex settings, changing 135

E
EconoMode setting 141
economy settings 141
electronic faxes

sending 98
email, scanning to

resolution settings 187
Embedded Web Server

changing network settings 133
changing password 140
changing product name 133
opening 133, 140

enlarging documents
copying 59

error messages, control panel
157

error messages, fax 109, 114,
120

error report, fax
printing 108

error-correction setting, fax 108
errors

software 208
extension phones

receiving faxes from 76
sending faxes from 100

F
factory-set defaults, restoring 155
fax

answer mode 87
autoreduction 90
billing codes 85
blocking 88
canceling 93
confirming number 100
contrast setting 84
delaying sending 100
deleting from memory 93
detect-dial-tone settings 82
dial prefixes 82
dialing, tone or pulse 83
error report, printing 108
error-correction 108

extension phone receiving 76
forwarding 87
pauses, inserting 82
polling 92
printing 102
printing private faxes 104
private receive 91
receiving when you hear fax

tones 104
redial settings 83
reports, printing all 107
reprinting faxes 90
reprinting from memory 103
resolution 84
ring patterns 89
rings-to-answer 88
security, private receive 91
sending from a telephone 100
sending from software 98
solve general problems 126
speed dials 98
stamp-received 91
unable to receive 120
unable to send 114
using DSL, PBX, or ISDN 94
using VoIP 95
V.34 setting 108
volume settings 90

fax date, setup
use control panel 77
use HP Fax Setup Wizard 77

fax header, setup
use control panel 77
use HP Fax Setup Wizard 77

fax time, setup
use control panel 77
use HP Fax Setup Wizard 77

fax troubleshooting
checklist 105

faxing
from a computer (Mac) 98
from a computer (Windows)

98
Fit to Page setting, fax 90
fonts

lists, printing 6
forwarding faxes 87
fraud Web site 216
front cover, locating 2

G
gateway, setting default 133
glass, cleaning 182, 186, 192
group-dial entries

creating 80
deleting 80
editing 80

H
help, control panel 156
Home screen, control panel 4
HP Device Toolbox, using 136
HP Embedded Web Server

changing network settings 133
changing password 140
changing product name 133
opening 133, 140

HP ePrint, using 50
HP fraud Web site 216
HP Reconfiguration Utility

network installation 130
HP Scan software (Mac) 69
HP Scan software (Windows) 68
HP Utility for Mac

Bonjour 138
features 138
opening 138

HP Utility, Mac 138
HP Web Jetadmin 139
HP Web Services

applications 132
enabling 132

HP Web Services, enabling 50

I
identification cards

copying 60
input tray

loading 13
locating 2

interface ports
locating 3

IPv4 address 133
ISDN

faxing 94

J
jams

document feeder, clearing
168

locating 167
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output bin, clearing 174
preventing 166
tracking number of 6

Jetadmin, HP Web 139

L
landscape orientation

changing (Mac) 43
changing (Windows) 34

lightness
copy contrast 62
fax contrast 84

link speed settings 135
loading paper

input tray 13
lock

product 140
logs, fax

error 108
printing all 107

M
Mac

driver settings 24, 41
HP Utility 138
problems, troubleshooting 210
scanning from TWAIN-

compliant software 74
managing network 133
media

pages per sheet 42
memory

deleting faxes 93
reprinting faxes 103

menus, control panel
map, printing 6

messages, control panel 157
Microsoft Word, faxing from 99
model number, locating 3
multiple pages per sheet 42

printing (Windows) 32
multiple-page originals

copying 56

N
n-up printing 42

selecting (Windows) 32
network

password, changing 140
password, setting 140
product name, changing 133

settings, changing 133
settings, viewing 133

network port
locating 3

networks
configuration page 6
default gateway 133
installing the product 130
IPv4 address 133
settings report 6
subnet mask 133

non-HP supplies 216
number of copies, changing 55

O
OCR software 74
online help, control panel 156
optical character recognition

software 74
optional Tray 3

part numbers 216
ordering

supplies and accessories 216
ordering supplies

Web sites 215
orientation

changing (Mac) 43
changing (Windows) 34

output bin
locating 2

outside lines
dial prefixes 82
pauses, inserting 82

P
page count 6
page orientation
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